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£ Custom View Settings

Topic 1 - Topic 1, Connecting to & Preparing Data

Question #1 Topic 1

What are two methods for renaming a field in a visualization? (Choose two.)

A. From the Data pane, use the field’s drop-down menu and select Rename.
B. From the Data pane, right-click the field and select Replace References.
C. From the Data pane, click and hold on the field until the name is editable.

D. From the Format menu, select Field Labels.

Question #2 Topic 1

Which statement accurately describes aliases?

A. You can assign an alias to a field member before creating a visualization.
B. When you assign an alias, the name changes in the database.
C. You can create an alias for a discrete measure.

D. You can create an alias for a continuous dimension.

Question #3 Topic 1

You need to invert the color intensity of a quantitative range.
Which option should you use?

A. Border

B. Reversed

C. Opacity

D. Stepped Color




Question #4 Topic 1

You need to display the complete list of potential data connections when you connect to a server.
What action should you perform?

A. Select Connecting to Data.
B. Select More under To a File.
C. Select More under To a Server.

D. Select File on the menu, and then select New.

Question #5 Topic 1

When creating a data source, how can you add additional connections to different databases?

A. From the drop-down menu of the current connection, select Edit Connection.
B. From the Connections pane, select Add.
C. From the Data menu, select New Data Source.

D. From the File menu, select New.

Question #6 Topic 1

What are two characteristics of relationships? (Choose two.)

A. Relationships will query every table in a data model regardless of whether the fields are in the visualization.
B. Relationships will query only the tables and fields needed to create a visualization.
C. Relationships are only supported when using extracts.

D. Relationships are aware automatically of the native level of detail of logical tables.

Question #7 Topic 1

What are two examples of a date value? (Choose two.)

A. January 1, 1995
B. December

C. Wednesday

D. 2020-05-01




Question #8 Topic 1 -~
What are three reasons to use joins instead of relationships? (Choose three.)

A. You need to use a specific join type.

B. You need to create an extract that will have multiple tables.

C. You need to use row-level security.

D. You need to use a data model that supports shared dimensions.

E. You need to connect to multiple databases.
Question #9 Topic 1

What are three benefits of using an extract as compared to a live connection to a data source? (Choose three.)

A. Alive connection to a data source provides the best performance for data connections.

B. Calculated fields perform better in workbooks connected to extracts than in workbooks with live connections to a data source.
C. Extracts are stored in memory (RAM), resulting in faster query performance as compared with live data connections.

D. An extract reduces the amount of data stored on a client computer as compared to a live data connection.

E. A live connection to a data source can be slow due to network and user traffic, whereas a connection to an extract improves performance.

Question #10 Topic 2

How can you access options to apply bold formatting to an axis in the view?

A. Select Text on the Marks card.
B. Select Field Labels on the Format menu.
C. Right-click on the Field and select Format.

D. Right-click on the axis.

Question #11 Topic 2

With the Marks card drop-down menu set to Automatic, a line chart will be created whenever you place what on the Rows shelf and the Columns
shelf?

A. Measures on one shelf, and a date dimension on the other
B. Zero or more dimensions on one shelf, and 2 or more measures on the other
C. Zero or more measures on one shelf, and 2 or more dimensions on the other

D. A date dimension followed by a continuous measure on one shelf




Question #12 Topic 2 -~
When should you use a relationship instead of a join for two data sets?

A. To use both data sets across multiple sheets in a visualization.
B. The data sets are in two separate tables within a single spreadsheet.
C. The data sets include similar data aggregated at different levels of detail.

D. The data sets include similar data aggregated up to the highest level.

Question #13 Topic 2

What is created by a calculated field that has a formula of SUM(Sales) / SUM(Profit)?

A. A measure
B. A dimension
C. Aset

D. A parameter

Question #14 Topic 2

Which two types of fields appear blue? (Choose two.)

A. Continuous measures
B. Discrete dimensions
C. Discrete measures

D. Continuous dimensions

Question #15 Topic 2

Which two filter modes can you use with dimension filters? (Choose two.)

A. Range of Values
B. At most
C. Wildcard Match

D. Multiple Values (drop-down)




Question #16 Topic 2

When viewing quick table calculations, such as Percent Difference from, that use a value in the previous column, what will be the first data value in
the visualization?

A. Zero (0)
B. Null
C. Duplicated from the nearest column

D. The current value

Question #17 Topic 2

Which two types of aggregations can be applied to string fields? (Choose two.)

A. Minimum
B. Sum
C. Average

D. Count Distinct

Question #18 Topic 2

You create a crosstab that shows a list of 100 hotel chains alongside their average nightly cost. You also create two groups showing, respectively,
the top 10 and bottom 10 hotel chains by cost, with subtotals.
What should you do to improve the crosstab and compare the two groups to all the remaining hotel chains?

A. Create a new view.
B. Color encode the hotel chain names.
C. Include an Other group.

D. Include the Summary card.

Question #19 Topic 2

You have the following string value: Sales Data.
Which calculated field produces an output of Sales?

A. LEFT (“Sales Data”)
B. LEFT (“Sales Data”, 5)
C. LTRIM (“Sales Data")
D. RTRIM (“Sales Data")




Question #20

You create a dual axis chart that shows sales and profit over time.
What should you do to distinguish sales from profit? (Choose two.)

A. Adjust the time frame displayed.
B. Change the mark types of sales and profit.
C. Adjust the aggregations for sales and profit to be different.

D. Change the color of sales and profit.

Question #21

What are two use cases for creating hierarchies from the Data pane? (Choose two.)

A. To organize related fields together
B. To add drilldown functionality for fields
C. To create faster-performing queries

D. To concatenate all fields into a single field

Question #22

From which three locations can you sort a visualization? (Choose three.)

A. The Analysis menu

B. Tooltip on the Marks card
C. An axis

D. The Worksheet menu

E. Afield label

F. A header

Question #23

Which statement accurately describes creating a group by selecting headers in a view?

A. The grouped dimension is added to Color.
B. A newly created group only exists in the current view.

C. A new group updates the aliases from the selected headers.

D. The grouped dimension replaces the original dimension field on Rows or Columns.
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Question #24 Topic 2

You want to provide additional information when hovering over a field in the Data pane as shown in the following exhibit.
g
© ProductName
#< Region Product Name
w< Segment including company
® ShipDate information.
~< Ship Mode
w< Measure Names
What should you configure for the field?

A. An alias
B. A header label
C. A default comment

D. A hierarchy

Question #25 Topic 2

You are creating a combined axis chart.
Where should you drag the second measure after dragging the first measure to the Rows shelf?

A. The Marks card
B. The Filter card
C. The horizontal axis in the view

D. The vertical axis in the view

Question #26 Topic 2

To best improve the display of a scatter plot that has overlapping shapes, you should adjust the ______ of the marks.

A. mark size
B. mark borders
C. color opacity

D. color palette

Question #27 Topic 2

The option to create bins is available for which type of field?

A. Boolean
B. Numeric
C. Date

D. String




Which mark type is used in a highlight table?

A. Area
B. Square
C. Polygon

D. Text

You have the following visualization.
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You need to show how Internet Usage values change from year-to-year as a percentage.
Which quick table calculation should you apply to the Internet Usage field?

A. Percentile
B. Difference
C. Compound growth rate

D. Percent difference

2009

2010

12

20



Question #30

You have a bar chart that has a dimension on the Columns shelf and a measure on the Rows shelf.
How can you make a stacked bar chart?

A. Drag another measure to Color on the Marks card.
B. Drag another measure to the left of the measure on the Rows shelf.
C. Drag another dimension to Size on the Marks card.

D. Drag another dimension to Color on the Marks card.

Question #31

Which three elements are included in a packaged workbook (.twbx)? (Choose three.)

A. Background images

B. A PDF copy of the workbook

C. Custom shapes

D. Tableau Datasource Customization (TDC) files

E. Extract files

Question #32

In which situation should you save a workbook as a PDF document?

A. Your users have Tableau Desktop but not Tableau Reader.
B. You want document users to be able to filter and sort the views.
C. Your analysis does not require a live connection to a data source.

D. You need paper copies of the workbook.

Question #33

What are three ways to access bolding options for the text in a tooltip? (Choose three.)

A. Hover over a mark and press CTRL+B.

B. Hover over a mark and press ALT+F.

C. Right-click on the Field and select Format.

D. Select Worksheet on the menu, and then select Tooltip.
E. Select Tooltip on the Marks card.

F. Select Format on the menu, and then select Font.
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Question #34 Topic 3

What is a Tableau story point?

A. A collection of sheets arranged in a sequence
B. A collection of talking points to drive the story
C. The pane where you set the size of the story

D. An individual sheet or dashboard in the story

Question #35 Topic 3

The Shape option is available for which two views? (Choose two.)

A. Scatter plots
B. Side-by-side circles
C. Heat maps

D. Packed bubbles

Question #36 Topic 3

Which statement accurately describes adding a dashboard layout for a mobile device?

A. Dashboards designed in portrait mode are optimal for viewing on a phone.
B. Dashboard device layout changes will be saved between workbooks.
C. Only workbooks published to Tableau Online support mobile layouts.

D. Dashboard changes made for one device layout apply to other device layouts.

Question #37 Topic 3

What are two use cases for a story? (Choose two.)

A. Present a data narrative to lead your audience to your conclusions.
B. Provide additional editing and interactive capabilities to your audience.
C. To allow for easier exporting to Power Point.

D. Assemble a sequenced analysis to share with collaborators.




Question #38 Topic 3 -~

What two methods can you use to change the font of a worksheet title? (Choose two.)

A. Select Format on the menu, and then select Title and Caption.
B. Select Format on the menu, and then select Font.
C. Double-click the title in a particular view and use the dialog box.

D. Right-click the title in a view, and then select Format Title.

Question #39 Topic 4

Which three statements accurately describe dimensions? (Choose three.)

A. Contain qualitative values

B. Affect the level of detail in the view

C. Affect the formatting options in the view
D. Can be continuous or discrete

E. Contain numeric, quantitative values

Question #40 Topic 4

You need to access options to change a dimension's color palette.
In addition to the Marks card, what else can you use?

A. Edit in Shelf
B. Edit Caption
C. The Format menu

D. The Color legend

Question #41 Topic 4
When creating a date filter in Tableau, to what does Anchor relative to refer?

A. The latest date in the data source that can be found.
B. The mid-point in the range of displayed dates.
C. The date in a relative-date filter to which you anchor a unit of time.

D. The date in a range-of-dates filter to which you anchor units of time.




Question #42 Topic 4 -~
What is the default behavior of Tableau when you add a measure to the view?

A. An aggregation is applied that varies depending on the context of the view.
B. You are prompted to add an aggregation.
C. The measure is added disaggregated.

D. An aggregation is applied that is independent of the context of the view.

Question #43 Topic 4

In an extract, what are three differences between a full refresh versus an incremental refresh? (Choose three.)

A. An incremental refresh can only be run from Tableau Server.

B. A full refresh is usually very slow. An incremental refresh can take less time.

C. A full refresh replaces all the extracted data with the data in the underlying data source.
D. An incremental refresh only adds rows that are new

E. A full refresh must be configured. An incremental refresh is the default extract in Tableau.

Question #44 Topic 4

Which of the following is a discrete date part?

A. February

B. 01/23/2021

C. 20Sep2016:9:8:8:6546
D. 07Mar2017

Question #45 Topic 4

Which two types of data are represented as measures in Tableau Desktop? (Choose two.)

A. Numerical totals such as test scores, sales and profit totals
B. Quantities such as student enrollment and products sold
C. Names of people such as students and customers

D. Years such as 1989, 2006, and 2020




Question #46 Topic 5

You have a dashboard. You want users to be able to identify specific marks that appear in multiple sheets without losing the context of all the data
in the view.
Which dashboard action should you use?

A. URL action
B. Filter action
C. Highlight action

D. Set action

Question #47 Topic 5

When altering the data type of a field, what are two available data type options? (Choose two.)

A. Scientific
B. Date
C. Vector

D. Number (decimal)

Question #48 Topic 5

You have a continuous numeric measure named Sales.
Which chart type is created when you double-click the Sales measure?

A. Atext table
B. A bar chart
C. Aline chart

D. A pie chart

Question #49 Topic 5

What are three geographic roles that you can assign to a field? (Choose three.)

A. Address
B. Time zone
C. Airport

D. Country

E. City




Question #50 Topic 5

Which action describes the process for changing a measure so that it automatically aggregates an average instead of a sum?

A. Right-click the field in the Data pane and select Change Data Type to change it.
B. Add the field to the view, right-click the axis, and select Format to change it.
C. Right-click and drag the field into the view to change it.

D. Right-click the field in the Data pane and select Default Properties to change it.

Question #51 Topic 5

What is a valid use case for a bar chart?

A. To compare measures across categories at a glance
B. To see relationships between measures
C. To see individual data points while also viewing associated categories

D. To compare multiple dimensions over an extended period

Question #52 Topic 5

Which two statements accurately describes measures? (Choose two.)

A. They affect the level of detail in the view
B. They contain qualitative values
C. They can be continuous or discrete

D. They contain numeric, quantitative values

Question #53 Topic 5

You have a field named Region in a data source Region contains the following values:
North -

East -

South -

West -

You need to ensure that Region always sorts in the order of East, South, North, and West when placed onto any worksheet.
What should you use?

A. The Sort indicator on the axis
B. The Sort menu on the legend
C. The Sort by Field menu

D. The Default Properties of the field from the Data pane




Question #54 Topic 5 -~

Which two options can you use to change the device layout of a dashboard? (Choose two.)

A. The Layout pane
B. The Dashboard menu
C. The Dashboard pane

D. The Format menu

Question #55 Topic 5

Which two types of data are represented as dimensions in Tableau Desktop? (Choose two.)

A. Names of people such as students, customers, and so on
B. Numerical totals such as test scores, sales and profit totals, and so on
C. Names of regions such as East, West, and so on

D. Tableau-generated latitude and longitude coordinates

Question #56 Topic 5

Which aggregation is available without requiring a table calculation or calculated field?

A. Percent of total
B. Running total
C. Sample covariance

D. Standard deviation




Question #57

You create the following visualization.
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What is the first step to create the visual grouping of the 10 marks shown in blue?

A. Select the desired 10 marks in the view
B. Select the desired 10 text labels under Property Description
C. Create a Group on the Property Description field in the Data pane

D. Create a Set on the Neighborhood field in the Data pane

Question #58
What are three options to change the scope of a reference line? (Choose three.)

A. Maximum
B. Entire Table
C. Per Pane

D. Fill Above
E. Per Cell

Question #59
Which statement accurately describes an extract when the Physical Tables option is selected?

A. Data is limited to only the Top N of data for the connection
B. An individual table is created for each physical table in the extract
C. Data shown in the Data pane is separated based on the table type

D. All the data is rolled up to the current visible fields
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Question #60 Topic 5

When creating an extract, what are three options for specifying how much data to extract? (Choose three.)

A. Apply afilter

B. Aggregate data for visible dimensions
C. Append Data from Files

D. Compute Calculations Now

E. Hide all unused fields

Question #61 Topic 5

You have a dashboard that shows car rental statistics by city, including a field named Car Dropoff City in the view. A URL action in the dashboard
uses https://en.wikipedia.org/wiki/<Car Dropoff City> as the URL target.
When you click Salt Lake City in the view, to where will the URL action direct you?

A. https://en.wikipedia.org/wiki/Salt_Lake_City

B. https://en.wikipedia.org/wiki/Salt+Lake+City+Car+Dropoff+City
C. https://en.wikipedia.org/wiki/<Car Dropoff City>

D. https://en.wikipedia.org/wiki/<Salt-Lake-City>

Question #62 Topic 5

How can you select a non-default shape palette?

A. Select Shape on the Marks card and use the drop-down menu in the Edit Shape dialog box
B. Click the drop-down menu at the top of the Marks card to change from Automatic
C. From the File menu, select Import Workbook to import other shape palettes

D. From the Data Source tab, select Connect to Data to import other shape palettes

Question #63 Topic 5

Which chart type uses automatically generated sizes that cannot be resized by using the Marks card?

A. Heat maps

B. Density map

C. Side-by-side circles
D. Packed bubbles




Question #64 Topic 5

You have a visualization that uses multiple types of sorting.
How can you clear all sorting of the visualization?

A. From the Dashboard menu, select Clear.
B. Right-click a sorted field, and then select Clear Sort.
C. From the Worksheet menu, select Clear, and then select Sorts.

D. From the Header label, select the sort icon.

Question #65 Topic 5

Tableau will automatically create a hierarchy for which two kinds of data? (Choose two.)

A. Date & Time
B. Date
C. String

D. Geographic

Question #66 Topic 5

What are two ways that dimensions and measures are different? (Choose two.)

A. Dimensions can be used in calculated fields and measures cannot
B. Measures are aggregated and dimensions are not
C. Dimensions affect the level of detail of a visualization and measures do not

D. Measures can be used as filters and dimensions cannot

Question #67 Topic 5

At a minimum, what do you need to create a simple scatter plot?

A. A measure on Columns and a measure on Rows
B. A dimension on Detail and a measure on Columns
C. A dimension on Columns and a measure on Rows

D. A dimension on Columns and a dimension on Rows




Question #68 Topic 5

Which statement accurately describes a join?

A. A combination of columns appended from different tables that have similar values
B. A way to combine table columns in relational databases by using shared values
C. A way to combine multiple Tableau workbooks using similar data sources

D. A combination of rows appended from different tables that have the same column names

Question #69 Topic 5

Which two filter modes can you use with continuous filters? (Choose two.)

A. Multiple Values
B. Single Values
C. Range of Values

D. Special

Question #70 Topic 5

Which three statements accurately describes the capabilities of dashboard actions? (Choose three.)

A. Can have multiple source and target sheets
B. Can be set to run on Hover. Select, or Menu
C. Can be set to Filter, Highlight, or Go to URL
D. Can be set to dynamically update when a workbook opens

E. Can be set to be triggered on a data value

Question #71 Topic 5

When creating a histogram in Tableau, to what does bin size refer?

A. The maximum number of marks in the view
B. The range of the continuous measure counted in each bin
C. The count distinct (COUNTD) of items on either axis

D. The minimum number of axis ticks in the view




Question #72 Topic 5

A dual axis chart is useful for comparing two measures that

A. are Table Calculations
B. have different scales
C. are aggregated Dimensions

D. have little in common

Question #73 Topic 5

When using a data source that has relationships, how can you add a join between two or more tables?

A. Double-click a logical table in the canvas
B. From the Tables pane, drag a table directly on top of an existing logical table
C. From the Tables pane, double-click a table

D. From the Connections pane, select Add

Question #74 Topic 5

What should you use to display data over a range of linear time, from the first point in chronological time to the last?

A. A continuous date value
B. The DATEDIFF date calculation
C. The DATEPARSE date calculation

D. A discrete date part

Question #75 Topic 5

What are two correct methods to change the data type of a field? (Choose two.)

A. From the Data Source tab, click on the drop-down menu of the field
B. From the Data pane, select and hold the field
C. From the Data Source tab, click the data type icon of the field

D. From the Data pane, click on the drop-down menu of the field




Question #76 Topic 5

Which two actions can you perform when you join tables from multiple connections? (Choose two.)

A. Add a data source filter
B. Create a union
C. Use a stored procedure

D. Create an extract

Question #77 Topic 5

What are two correct methods for creating a visual group? (Choose two.)

A. Right-click a dimension in the Data pane
B. Click the drop-down arrow from the top of the Data pane
C. Select marks in the view

D. Drag a dimension onto another dimension in the Data pane

Question #78 Topic 5

What should you use to create an axis in a visualization?

A. A measure
B. A parameter

C. A dimension

D. Afilter
Question #79 Topic 5
To display data that has both negative and positive quantitative values, Tableau Desktop will display marks by using as
the default.

A. a sequential palette
B. the full color range
C. a diverging palette

D. a categorical palette




Question #80 Topic 5

You need to apply the same font to an entire workbook at one time.
What should you do?

A. Select Format on the menu, and then select Field Labels
B. Select Format on the menu, and then select Workbook
C. Select Help on the menu, and then select Settings and Performance

D. Select Format on the menu, and then select Title and Caption

Question #81 Topic 5

You have the following legend.

Air Ticketing Cabin Type Name ZI' ‘

M Business Class

M First Class

M Premium Economy Class
M Economy/Coach Class

B Unknown

What occurs when you click the icon to the right of Air Ticketing Cabin Type Name?

A. The legend toggles on or off
B. The highlighter toggles on or off
C. The filter options open

D. The Edit Colors dialog box opens

Question #82 Topic 5

You need to uniformly change the size for all marks in a view.
What should you do?

A. Use the Fit dropdown menu on the toolbar
B. Select Format on the menu, and then select Cell Size
C. Select Size on the Marks card and use the slider to adjust the size

D. Select Label on the Marks card and then select Alignment




